Micro Focus Visual COBOL SOA 2.1 for Visual Studio

Release Notes
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Micro Focus Visual COBOL SOA for Visual Studio 2010 Release Notes</td>
<td>4</td>
</tr>
<tr>
<td>System Requirements for Visual COBOL SOA for Visual Studio 2010</td>
<td>5</td>
</tr>
<tr>
<td>Hardware Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Operating Systems Supported</td>
<td>5</td>
</tr>
<tr>
<td>Software Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Installing Visual COBOL SOA for Visual Studio 2010</td>
<td>7</td>
</tr>
<tr>
<td>Installation Restrictions and Requirements</td>
<td>7</td>
</tr>
<tr>
<td>Downloading the Product</td>
<td>8</td>
</tr>
<tr>
<td>Installing</td>
<td>8</td>
</tr>
<tr>
<td>Installing as an Upgrade</td>
<td>8</td>
</tr>
<tr>
<td>After Installing</td>
<td>8</td>
</tr>
<tr>
<td>Repairing</td>
<td>9</td>
</tr>
<tr>
<td>Installing Mainframe Access Server</td>
<td>9</td>
</tr>
<tr>
<td>Uninstalling</td>
<td>12</td>
</tr>
<tr>
<td>Licensing Information</td>
<td>13</td>
</tr>
<tr>
<td>Known Issues</td>
<td>14</td>
</tr>
<tr>
<td>Updates and SupportLine</td>
<td>15</td>
</tr>
<tr>
<td>Further Information and Product Support</td>
<td>15</td>
</tr>
<tr>
<td>Information We Need</td>
<td>15</td>
</tr>
<tr>
<td>Creating Debug Files</td>
<td>15</td>
</tr>
<tr>
<td>Disclaimer</td>
<td>17</td>
</tr>
</tbody>
</table>
Micro Focus Visual COBOL SOA for Visual Studio 2010 Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety before you install the product.

⚠️ Note: This document contains a number of links to external Web sites. Micro Focus cannot be responsible for the contents of the Web site or for the contents of any site to which it might link. Web sites by their nature can change very rapidly and although we try to keep our links up-to-date, we cannot guarantee that they will always work as expected.

Visual COBOL SOA includes support for deploying native COBOL applications as Web services or accessed from J2EE applications under Enterprise Server.

Project templates also enable deployment of Mainframe Subsystem applications to Enterprise Server, these templates will not work without mainframe subsystem license and should not be used under a Visual COBOL SOA license.
System Requirements for Visual COBOL SOA for Visual Studio 2010

Hardware Requirements

Visual COBOL SOA has the following requirements in addition to the requirements of Microsoft Visual Studio. See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are:

- 58MB for the Sentinel RMS license server
- 200MB for Micro Focus COBOL integration into Visual Studio

**Note:** This includes the space needed to cache information locally so that you can modify the installation without the original source media.

Operating Systems Supported

**Note:** You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The following platforms are supported:

- **32-bit Windows Platforms**
  - Windows Vista
  - Windows 7
  - Windows 8

- **64-bit Windows Platforms**
  - Windows Vista
  - Windows 7
  - Windows 8

- **Citrix and Terminal Server**
  - Windows 7
  - Windows 8

Software Requirements

**Note:** If you use the Micro Focus Web Installer to install this product, it checks your system and installs the missing prerequisite software.

If you choose to install using the full image, you need to install the following software beforehand:

- A full version of Microsoft Visual Studio 2010 (Premium, Professional, or Ultimate), or the Microsoft Visual Studio Integrated Shell.

**Note:**
- Microsoft Visual Studio Express Edition is not supported.
• You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If you choose to install the Shell, ensure you run the installer to complete the installation - run vsintshell.enu.exe from the location where you installed the download.

The following functionality, tools and features have additional requirements:

Visual Studio IDE

• Microsoft Windows SDK is required if you are using Visual Studio Shell. See the Microsoft Download site and search for Windows SDK.
• Microsoft .NET Framework 4.0. This is included with the above versions of Visual Studio.

Enterprise Server

• A Web browser, such as Microsoft Internet Explorer 6.0 or Netscape Navigator 6.1, is required for Enterprise Server Administration in COBOL Server SOA.
  To use your Web browser offline, you need the dial-up networking feature of Windows installed. Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent (127.0.0.1).
• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your browser. This is on by default in Internet Explorer in most Windows operating systems, apart from Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in Internet Explorer:
  1. Click Tools > Internet Options.
  2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click Enable.
  3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable the Search facility to work.

Windows Forms

• Microsoft Internet Information Service (IIS) is also required for generating Windows Forms test clients.

XML Extensions

• XML Extensions has the same requirements as RM/COBOL version 12 for 32-bit Windows. (See the RM/COBOL User's Guide, Second Edition or later.) Additionally, XML Extensions may be used in conjunction with Terminal Server.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software. For local servers, you do not need to install it separately, as the setup file installs a new Visual COBOL SOA client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the client is not able to communicate with license servers of versions older than 10000.2.660. On Windows, you can check the version of your license server by clicking Help > About in the Micro Focus Licensing System Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine Web site: http://supportline.microfocus.com/websync/SLM.aspx.
Installing Visual COBOL SOA for Visual Studio 2010

Note:
- This version of the product is a full install.
- It is recommended to install this product using the Web Installer. The Web Installer helps you install any missing prerequisite software and the product on your machine.

Installation Restrictions and Requirements

Before starting the installation you should consider the following:

- Visual COBOL SOA and COBOL Server SOA cannot co-exist on the same machine.
- Visual COBOL and Enterprise Developer cannot co-exist on the same machine.
- If, when you install Visual COBOL SOA, the machine does not have Microsoft Visual C++ 2010 Redistributable Runtime already installed, it is installed as required by Visual COBOL SOA. The installation of Microsoft Visual C++ 2010 Redistributable Runtime adds a number of .dll files, without digital signatures, into the winsxs directory.
- If you are installing this as an upgrade, make sure that none of the product files are in use when you start the installation.
- You need to be logged in with a user-ID that has write access to the registry structure under HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation software can set the environment appropriately. You also need to be logged on with Administrator privileges.
- Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or CCITCP2 Windows service from an existing product is stopped and uninstalled. Do this as follows:
  1. Stop the service, using either the Windows Service Management Console GUI or from a command line prompt by typing: `net stop mf_ccitcp2` Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
  2. Uninstall the MFDS or CCITCP2 service.
     - For MFDS, from a command line prompt enter: `mfds -u`
     - For CCITCP2: `ccitcp2 -u`

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:
   a. Open a Enterprise Developer command prompt.
   b. Install the service. Enter the following command: `mfds -i`
   c. Start the service. Enter the following command: `net start mf_ccitcp2`

Note: The two versions use different paths for environment and registry values, so the list of configured Enterprise Servers might be different depending on which version has been started, since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later versions.
It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the "mfcobol" port is used (86) and this can only be used by one process at a time.

**Downloading the Product**

1. Use the download links in your Electronic Product Delivery email.
   
   For more information follow the links for the install instructions and the End User License Agreement.

**Installing**

To use the Web Installer:

2. Click `Start` in the Web Installer dialog and follow the instructions to install the prerequisite software and the product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Run the `EnterpriseDeveloperVisualStudio21.exe` file and follow the wizard instructions to complete the installation.

**Note:**

- If you are installing onto a machine that has an existing Micro Focus product that uses an older Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus License Manager. By doing this you maintain the existing Sentinel RMS license files while adding the Micro Focus License Manager. If you are unsure about existing licenses on your computer or removing the Sentinel RMS License Manager, consult your System Administrator. If you want to proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs and rerun the installation file.
- Trial licenses cannot be used with remote desktop services. If you want to use your product in this way, please contact Micro Focus SupportLine to obtain a relevant license.
- We recommend that you install any updates for Visual Studio and the .NET Framework that are available at the Microsoft Download site.
- If you install JDK you might be prompted to install the latest update. The latest update is not required for use with Visual COBOL SOA but you can install it if you wish.

**Installing as an Upgrade**

This release does not work concurrently with earlier releases and installing it uninstalls previous versions of the product.

Before installing, check Installation Restrictions and Requirements.

**After Installing**

You are now ready to run Visual COBOL SOA. From the Windows taskbar click Start > All Programs > Micro Focus Enterprise Developer > Visual COBOL SOA for Visual Studio 2010.

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find information on getting started including tutorials and demonstration programs.
If you have problems trying to view the Micro Focus help, ensure that the Visual Studio Help Library is pointing to local help. From the Visual Studio menu click Help > Manage Help Systems > Choose online or local help and check the I want to use local help button.

**Note:** The first release of Visual Studio 2010 has a browser-based help system, Microsoft Help Viewer 1.0, which does not include an index for the locally-installed help. Navigation of the content is only available using the table of contents and Search and the help contents for the Help system does not expand and collapse in the same way as previous Help systems.

Visual Studio 2010 SP1 provides an upgrade of the help system, Microsoft Help Viewer 1.1, which provides a stand-alone help viewer with an index and a fully expandable table of contents.

If you do not wish to install Visual Studio 2010 SP1, you can install some third party tools that enable the index or the fully expanding table of contents. Read [http://kb.microfocus.com/display/4/kb/article.aspx?aid=31484](http://kb.microfocus.com/display/4/kb/article.aspx?aid=31484) for more.

### Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a Repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

### Installing Mainframe Access Server

#### Introduction

The installation process for Mainframe Access Server uses a single FTP operation to transfer all of the mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the remaining installation activities are all done on the mainframe. You customize and submit the pre-built FRESTORE job to restore the product data sets from the uploaded files and then continue with customization steps to create an operational Mainframe Access Server.

#### Requirements

- IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher
- two APPLIDs, two TCP/IP ports
- APF security authorization support personnel availability
- Access to a network share with acceptable space for source and data, as well as the ability to access the IP address and ports used to access MFA
- The following installation-specific variable information:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>drive</td>
<td>TSO user-ID for FTP to your mainframe</td>
</tr>
<tr>
<td>userid</td>
<td>TSO password for the FTP user-ID</td>
</tr>
<tr>
<td>pswd</td>
<td>TCP/IP host name or IP address of your mainframe</td>
</tr>
<tr>
<td>your.mainframe.name</td>
<td>TCP/IP host name or IP address of your mainframe</td>
</tr>
<tr>
<td>prodhlq</td>
<td>A NEW high level qualifier that will be assigned for all Host Connectivity data sets when the new Mainframe Access product is installed. These are NOT existing</td>
</tr>
</tbody>
</table>
**Variable | Description**
---|---
| | product data sets, but rather brand new files that you will be creating for this base version.

**Important:** The installation of a new version creates new product run-time data sets before the upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can be used for fallback. If you prefer to retain your former production library names and re-use your existing prodhlq then rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages MFM0001I and MFM0014I on the syslog and XDBOUT sysout data set show the maintenance level at startup. You may need to know what level you are upgrading from when you complete post-installation customizations for this upgrade.

**Install Mainframe Access Server**

In the instructions that follow, the information that you must provide is shown as one of the variable names from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value is MY.MFA, then substitute MY.MFA for prodhlq.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlq.UPLOAD to receive the uploaded files. Use the following data set characteristics for this upload library:

   - DSORG=PO
   - RECFM=FB
   - LRECL=80
   - BLKSIZE=3120
   - SPACE=(3120,(3500,500,50))

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that you see may differ slightly from those shown in this example.

   a. Start FTP:

      ```
      C:\>ftp your.mainframe.name
      Connected to your.mainframe.name.
      220-FTPD1 IBM FTP CS/390 VxRy at YOUR.MAINFRAME.NAME, hh:mm:ss
      220 Connection will close if idle for more than 5 minutes.
      User (your.mainframe.name:(none)): userid
      331 Send password please.
      Password: pswd
      230 userid is logged on. Working directory is "userid.".
      ```

   b. Change the working directory on the mainframe to be the upload library that you allocated:

      ```
      ftp> cd 'prodhlq.UPLOAD'
      250 The working directory "hlq.UPLOAD" is a partitioned data set.
      ```

   c. Set file transfer type to binary:

      ```
      ftp> binary
      200 Representation type is Image
      ```

   d. Set FTP prompting off to transfer all files without interruption:

      ```
      ftp> prompt
      Interactive mode Off.
      ```

   e. Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:

      ```
      ftp> mputdrive:\upload\f*
      200 Port request OK.
      ```
Storing data set prodhlq.UPLOAD(Fxxxxxxx)
Transfer completed successfully.
ftp: xxxx bytes sent in x.xx seconds (xxx.xx Kbytes/sec)

f. When mput has transferred all files the ftp> prompt appears. End the FTP connection:

ftp> quit
221 Quit command received. Goodbye.

g. On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the \Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should be 10 members, F1 through to F9 and FRESTORE.

4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the instructions in that member to customize the JCL and then submit that job to restore the product libraries from the uploaded files and populate your new product runtime libraries.


After installation

Since the program libraries can change between versions, it is necessary to either create new procedures, or back up the old procedures, and at least modify the DSNQUAL=prodhlq within your MFA sample started task procedures as provided by Micro Focus. The prodhlq.LOADLIB and prodhlq.SASC.LINKLIB must both be authorized.

Verify successful maintenance application by checking the Mainframe Access Server startup message:

MFM0001I: Mainframe Access V4.00 (BASE ) is active

The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access Data Connect server startup message:

MFA303I MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS...

When you are satisfied with the new version installation you may delete the UPLOAD data set from your system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.

<table>
<thead>
<tr>
<th>Member</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MFA</td>
<td>sample MFA started task</td>
</tr>
<tr>
<td>MFAS</td>
<td><em>new</em> sample MFAS started task for Data Connect</td>
</tr>
<tr>
<td>MFAAS</td>
<td>sample MFAAS application server started task</td>
</tr>
<tr>
<td>MFAVTAM</td>
<td>sample MFA VTAM definitions</td>
</tr>
<tr>
<td>PARMS</td>
<td>sample PARMS for MFA started task</td>
</tr>
<tr>
<td>PARMSAS</td>
<td>sample PARMSAS for MFAAS started task</td>
</tr>
<tr>
<td>SERVERS</td>
<td>sample SERVERS configuration for MFA</td>
</tr>
<tr>
<td>UPQUICK</td>
<td>configuration notes</td>
</tr>
</tbody>
</table>

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your existing CNTL members from your current version as an installation test. You can simply copy the existing MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however be required to modify the MFAS started task JCL since the module names for Data Connect have been changed to allow co-residence within the same authorized library as MFA.

Review the Change Log in each of the new members. Read the documentation for any new parameters in the Readme and in the updated Mainframe Access Administrator’s Guide. Add these new parameters and other changes to your working copies. If necessary, customize the new parameters for your installation.
Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration settings into the new high-level qualified CNTL members.

Uninstalling

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. On versions of Windows Vista and later, click View installed updates in the left-hand pane.
5. Select the product and click Remove or Uninstall, respectively.

When you uninstall, the only files deleted are those that the installation software installed. If the product directory has not been removed, delete any unwanted files and subdirectories within it using Windows Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL SOA and Micro Focus License Manager. Uninstalling only Visual COBOL SOA does not automatically uninstall the Micro Focus Licensing Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus Licensing Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete them.

The following folders might not be removed:

- The Micro Focus Product Name folder in the Start menu - you can delete it manually.
- %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log files of the samples which you have built.
- %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
- %Program Files%\Micro Focus - you can delete it manually.

In addition, the following registry entries are not removed. These are created the first time that an Enterprise Server that has been enabled for performance monitoring starts up:

- Micro Focus Server\Performance\Active Servers
- Micro Focus Server\Performance\PerfIniFile
Licensing Information

**Note:**
- This release uses the license keys for the Visual COBOL SOA R4 release.
- This release requires the latest version of SafeNet licensing software. See *Software Requirements* in this document for more details.
- If you are unsure about what your licensing policy is or what sort of license you require, consult your System Administrator or Micro Focus SupportLine to obtain a valid license.

**Windows** Use the Authorization Code, supplied with your delivery notice, to license your product. To do this:

1. Click **Start > All Programs > Micro Focus License Manager > License Management System.**
   
   The dialog box for the Micro Focus License System Administration Tool will be displayed.
2. Click the **Authorize** tab.
3. Enter your Authorization Code and click **Authorize.**
4. Close the Micro Focus License System Administration Tool.

If you wish to install the license silently, execute the following after the product has been installed:

```
start /wait <install-dir>\bin\cesadmintool -term activate AuthorizationCode
```

**License for the Integrated Development Environment for Visual Studio**

Your product is supplied with an evaluation license that typically enables you to use your product for 30 days. While you are using the evaluation license, a dialog will display when you start your product prompting you to enter the Authorization Code. This code can be found in the **Requested License Key** email that is supplied when you order your product. Depending on your product order, you might have multiple license Authorization Codes. To obtain a full license for Visual COBOL SOA, enter the code that is printed under **Visual COBOL SOA - Visual COBOL SOA for Visual Studio.**

**Note:** If you have purchased a Visual COBOL SOA timed license, the license management system may show these as Trial licenses. This does not affect the license you have purchased.
Known Issues

Please, refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, please note the following:

**COBOL Watchpoints**
The debugger ignores a COBOL watchpoint that is hit if there is no statement following the statement that modifies the data on which that watchpoint is set.

**ICETOOL Emulation**
ICETOOL emulation for managed code is not available in this release.

**Enterprise Server**
On versions of Windows Vista and later, Enterprise Server listens only on the IPv4 loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a TN3270 emulator such as RUMBA may fail. To work around this issue, in your emulator's configuration use 127.0.0.1 in preference to localhost or your host machine's name.

**Native COBOL**
On Windows XP, when building a native COBOL application in Visual Studio, a dialog may pop up with error "Unhandled exception at 0xc0006866 in cobol.exe: 0xC0000005: Access violation reading location 0xc0006866". This is caused by Symantec antivirus runtime protection. To resolve this, you need to apply the following fix from Symantec:

Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

- The WebSync service, where you can download fixes and documentation updates.
- The Knowledge Base, a large collection of product tips and workarounds.
- Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web site, www.microfocus.com. If you obtained the product from another source, such as an authorized distributor, contact them for help first. If they are unable to help, contact us.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or you think some are irrelevant to your problem, please give whatever information you have.

- The name and version number of all products that you think might be causing a problem.
- Your computer make and model.
- Your operating system version number and details of any networking software you are using.
- The amount of memory in your computer.
- The relevant page reference or section in the documentation.
- Your serial number. To find out these numbers, look in the subject line and body of your Electronic Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump (.dmp) file. To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal (recommended), click Dump, then specify a location and name for the dump file. Once the dump file has been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the operation of a number of Micro Focus software components.

Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus technical support, your support representative might request that you provide additional debug files (as well as
source and data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either express or implied, including the warranties of merchantability and fitness for a particular purpose. In no event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect, incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2012. All rights reserved.